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Spring is back upon us. Thunderstorms,
tornado watches, and tornado warnings are
things that come with the annual arrival of
Spring, at least in my neck of the woods. In fact,
it’s the same thing in
Meemaw’s neck of the
woods too, especially since
she lives about three or four
hours away from me.

I keep looking at my yard,
thinking about how I haven’t
even gotten around to doing
my annual service routine
on my lawn mowers, and
the grass is high enough
that it’s begging to be
mowed. Of course, I don’t
have as much time as I
used to for such tasks.
When I’m home, I’m Mr.
Mom while Laura works.
When Laura is off, she’s
home with the kids while I’m
at work. That one day a
week that we have off
together … one of us is on
call at the hospital.

With the recent influenza
epidemic, we’ve been
getting called into work at
the hospital on the only day each week we have
for family time. It goes without saying that we’re
glad that we’re on the downhill side of the
influenza epidemic. Take it from someone who
works in the hospital, the flu was very, very bad

in our area this year. Now – maybe – we’ll
actually get some family time, with the hospital
not demanding every waking moment of our
lives.

I keep telling everyone at
work that (as of April), I’m
on the “8 and 3 plan.” That
is, 8 years, 3 months before
I can retire. I plan to retire
“early” at 65. I’ll take the
“penalty” for retiring two
years early, just so I can
stay home and raise my
kids. Plus, once my house
is paid off, my plan is to
reduce to part time hours,
just so we can have some
family time. My house
should be paid off within the
next three to four years. By
then, family time will be all
that much more important
to Ryan and Lexi, not to
mention mom and dad.

At least, that’s the plan. We
also want to buy some land
(around 10 acres) in the
country. We want to put a
small cabin on it, and we
can go there to hunt and

just get away from the hustle and bustle of the
city.

So, until next month, I bid you peace,
happiness, serenity and prosperity.

1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Disclaimer

From The Chief Editor's Desk ...
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by Meemaw

Each new update of most any program will present fixes, of course, but will also
usually add new features. LibreOffice is no exception. Besides the new
Notebookbar, which is getting mixed reviews, LO has added several new
features. The release notes are here. Let’s look at a few here. I must confess that
a couple of these may have been present in LO 5.2.5, but 5.3 was released
within two weeks of 5.2.5, so these may have run together.

Writer

Go to Page Dialog

Writer has a new dialog for quickly jumping to another page that is available
through Edit > Go to Page or Ctrl+G. If you have a multi-page document, this
will be faster and easier than scrolling.

The Styles and Formatting tool has a new addition: the tables format tool. If you
add a table, then go to Styles and Formatting, the last icon across the top of the
window is the tables formatting.

The Draw toolbox has an extended arrows section that even shows up in Writer
and Calc. If you use arrows a lot, you can even use it as it’s own toolbar or
window.

Calc

There is a change in the format options available in Format > Cells > Numbers
and in the Sidebar. You can format for fractions now, which I’ve never seen
before, or for scientific expressions. You are reminded of the expected format at
the bottom of the window so you can get things entered correctly. Shown below
are the Format Cells window, and also (at right) the Format Cells section in the
sidebar.

LibreOffice 5.3: New Feature Review

http://pclostalk.pclosusers.com
https://wiki.documentfoundation.org/ReleaseNotes/5.3
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Impress

The draw functions have always been visible in Draw, but now you can access
them in Impress as well. Just go to View > Toolbars > Drawing as usual. The
draw toolbar can be placed on the top, bottom or sides of the window.

It is now possible to export to PDF only the notes pages of your presentation.
You will have to use the File > Export to PDF menu to change the settings.

The Template Manager has a new user interface which looks easier to use.

Colors

The colors have been updated. From the release notes:
• Fix recent colors
• The custom palette is newly added, which allows colors to be added directly in the area

style dialog,
• Custom palette makes the manipulation of factory settings via Tools > Options >

LibreOffice > Colors obsolete ‒ and hence we deleted this option,
• The palettes gallery, web, cmyk, and scribus were removed because of the non-standard

and rather arbitrary collections with inappropriate names,
• Tango and html palettes received minor updates for labels and arrangement of colors,
• The standard palette was also refreshed. The first row now starts with 12 shades

of gray followed by 12 basic colors from the HSV color wheel. The next rows are
variations of these basic colors in respect to saturation and luminance by 66%, 50%,
and 25%. The final 12×8 arrangement fits perfectly into our color picker grid,
• The palette breeze has been added to the default set. It comprises all values known

from the KDE human interface guidelines as an alternative to tango,
• Completely new is the tonal palette. It aims to provide a set of colors with the same

luminance respective color contrast,
• The palette freecolour-hlc based on the CIE LAB color model has been added. Its

purpose is to provide a cross-media safe set of colors targeting expert publishers.

LibreOffice 5.3: New Feature Review
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In short, some ineffective color palettes have been omitted, a few updated ones
have been added, and the selection window has been changed, even in the
toolbar, so you can use whatever palette you want.

Keyboard Shortcuts

Keyboard shortcuts can now appear in context menus
and visibility can be set in Tools > Options > View >
Menu.

However, so far, I have the shortcuts shown no matter which setting I choose.

Extension Manager

From the release notes:
Revamped the Extension Manager dialog; replaced the
custom-implemented error-prone buttons and behaviours
with compatible standard widgets and behaviours, and fixed
various bugs in the process. The Extension Manager now
provides a better user experience and accessibility.

Adding extensions seems a bit easier to me now. I
remember having trouble with some of them. I don’t
use very many extensions, but a few of them are very
handy (top, right).

There’s one called GeoMap, which will insert a map into your Writer document
for an address you list. I’m still playing with that one. I live in a rural area outside
of my town, so many of the maps turn out almost blank, because there are less
streets (and apparently less accurate addresses), so it is no help. If you live in
the city (or at least in town) the map shows up well. You are given a GeoMap
toolbar (which is only one icon, a compass, outlined in red below), and clicking
on it, you see a window that contains several variables.

LibreOffice 5.3: New Feature Review
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Input the address you want, change the height and width to the desired size,
adjust the zoom from 1 to 17 depending on how close you want to zoom (1 is
farthest out), and click preview. If it looks the way you want, click OK. As far as I
can tell, you have to click Abort and start over if it’s not how you want it.

Format > Page

This window has some changes as well, mostly in the Area Dialog.

This menu has had a redesign and expansion. When you open it, you will see
buttons that say None, Color, Gradient, Bitmap, Pattern and Hatch. Clicking
on one of them (None is selected by default) will open the menu for that area and
allow you to choose what you want.

Customization Dialog

The Customization dialog has been updated, and is more user friendly. It has
customization sections for Menus, Context Menus, Keyboard Shortcuts, Toolbars
and Events. It seems much easier to use, and adding a command is easier than
it used to be (top, right).

So far it works pretty well for me, except that it has crashed while searching the
fonts list. It may be because it has removed support for a few my system still has.

Summary

As they add improvements to LibreOffice, I am liking it more and more. I like the
optional toolbar setup, so one can use whatever they want. My computer at work
has to have MS Office on it, but I have LibreOffice installed as well. I use
LibreOffice by default because I dislike the “ribbon” in MS Office: it’s actually one
of the main reasons I continue to use LibreOffice.

LibreOffice 5.3: New Feature Review

http://www.linuxfoundation.org/
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by phorneker

In the last article, I discussed the basics about the aTunes music player. aTunes
can be configured by selecting Edit → Preferences from the main menu. The
Preferences provides ways to customize your experience with the aTunes music
player.

General Settings: Here is where you can change the layout for display of panels
in aTunes. I discussed this in the last article, but in case you missed it, the red
and yellow blocks represent the music source panels. The blue block represents
the track being played. The green block represents the information panel.

You can also change the language used by aTunes, as well as select a built-in
theme. This example is the Raven theme, which is white text on dark (near black)
shades of grey with glossy buttons.

There are options to show the player as it fits in the system tray (for KDE, MATE,
and XFCE use), as well as an icon for easy access to aTunes from the system
tray.

You can also change the typeface used by aTunes for text display.

Repository Settings: Here you can include the contents of multiple directories
where music is stored into the local aTunes repository. There is an option to allow
aTunes to store and retrieve ratings on music tracks in the local repository.

aTunes: More Customizable Than You Think
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If any part of the local repository involves directories accessed on other servers,
on removable media such as external hard drives or flash drives, or restricted
access to directories anywhere, you can assign a command line to execute
before accessing the directory, and a command line to execute after aTunes is
done accessing the repository.

aTunes can automatically refresh the contents of the local repository in intervals
of 5 minutes, 10 minutes, 15 minutes, 30 minutes or 60 minutes from the time
aTunes was launched. A value of zero minutes here disables refreshing of the
repository.

Player Settings: aTunes uses MPlayer for music playback. Here you can
configure aTunes to start playing music immediately after startup and fade out the
music when you click on stop. If you have an internet connection with low
bandwidth, enabling the cache option would be useful to you in terms of
performance from aTunes.

Navigator Settings: This allows you to customize the listing of tracks in the
navigation panel. Here you can also show (or not show) tracks you marked as
Favorites, as well as whether to display on screen tool tips (useful when hovering
the mouse over buttons).

You can allow aTunes to ignore (or to consider) the word “the” in titles or artist
names, and to sort artist names by last name then first name, or first name then
last name, as well as to consider (or ignore) case sensitivity when sorting.

Selections here depend on your preferences.

Playlist Settings: These settings customize what happens with music playback
when you modify a playlist, or (if you have more than one playlist) change a
playlist. By default, music playback stops when you clear the current playlist, but
not when you change playlists. Also, tracks in the playlist scroll automatically
(depending on the length of the playlist), and the playlist selector is not showing.

aTunes: More Customizable Than You Think
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On Screen Display: aTunes can use notification systems available with Mac OS-
X and with the GNOME 3 desktop. Since PCLinuxOS does not supply either of
those notification systems, the Notification Engine setting is irrelevant here and
should be set to Default.

aTunes displays a on screen notification of the next track playing at the beginning
of each track. You can set the duration of the display to two, four or six seconds
from the beginning of the track.

Notifications are 400, 500, or 600 pixels in width, and are aligned as follows:

The display is relevant to the current monitor aTunes is being displayed on.

Context Information: Here is where you enable Google searches for artist and
track information, as well as for similar music by similar artists. You can also
configure where to search for lyrics to the current track that is being played.
LyricWiki and LyricsDirectory are enabled by default. You can also enable
LyrcEngine, Winampcn and LyrDB as sources for lyric information.

Import and Export Files: To facilitate import and export of audio files with
aTunes, you may customize formats for file and directory names. This is a matter
of personal preference, and is useful if you have a consistent structure for naming
audio files. For importing files, you have the option to review ID3 tags, apply any
ID3 tag changes to the original files, set track number and title of the track
automatically upon importing.

For most of us, we should leave the settings as is, and structures for music files
could be another topic for another issue.

Internet Settings: This setting is used of you are indirectly accessing the
Internet, i.e. you are accessing the Internet through a proxy such as a corporate
or academic gateway. For most of us, this is not the case, and the default setting
will work.

aTunes: More Customizable Than You Think

http://lyrics.wikia.com/
http://moodpoint.com/
http://winampcn.com.w3snoop.com/
http://search.cpan.org/~jbsoles/Lyrics-Fetcher-LyrDB-0.02/lib/Lyrics/Fetcher/LyrDB.pm
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LastFM: If you have a (premium) account with LastFM.com, you will be able to
use your login and password to allow aTunes access to your LastFM profile. As
mentioned in the Basics article, LastFM is completely optional and is not
required for use with aTunes. Also, it is best to leave the cache content setting
enabled as you do not want to cause problems with the LastFM service with
excessive number of requests for LastFM.

Anyone who has read the terms of service for LastFM knows the reason for this.

Device Settings: Here the location of your external device is set, be it a Second
Generation iPod Nano, a Sansa Fuze, or the latest Samsung Galaxy phone. (I
actually own a Second Generation iPod Nano and a Sansa Fuze.)

All other settings here are for the importing and exporting of tracks and/or track
listings to/from aTunes similar to the other Import and Export settings. By default,
aTunes allows for copying of the same song as it appears on different albums
such as a song that appears on the original album and on a greatest hits
collection.

Radio Settings: If an online radio station streams information as well as the
music, that information is read into aTunes and displayed. For example,
seeburg1000.com provides this information with the string “Best of Seeburg
1000” in the information panel as well as in the playlist.

Podcast Feeds: Podcast feeds are updated at intervals from three minutes to an
hour. You may set a directory where podcast feeds are downloaded. By default,
podcasts are downloaded and played from your local hard drive, and are not
removed when the podcast feed no longer provides them.

Be careful about disk space usage as podcasts tend to be large in size
(depending on the length and encoding), especially if you have limited hard drive
space on your disk.

aTunes: More Customizable Than You Think

http://seeburg1000.com/
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What we just discussed here is the Preferences
available to customize your aTunes experience.

Next time, we shall discuss the various ways to get
music into aTunes (besides setting up the repository
and importing music from the local hard drive, which
we have already done in the Basics article).

Screenshot ShowcaseScreenshot Showcase

A magazine just isn't a magazine
without articles to fill the pages.

If you have article ideas, or if you
would like to contribute articles to the

PCLinuxOS Magazine,
send an email to:

pclinuxos.mag@gmail.com

We are interested in general articles
about Linux, and (of course), articles

specific to PCLinuxOS.
Posted by Crow, March 5, 2017, running LXDE Education.

aTunes: More Customizable Than You Think

http://chimpbox.us
mailto:pclinuxos.mag@gmail.com
http://www.jupiterbroadcasting.com/tag/linux-action-show/
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by parnote & Meemaw

Earth Day in the USA is April 22. Many of the Earth
Day organizations are committed to maintaining the
planet, whether it be by reforestation, conservation
of natural resources or turning back climate change.

I work for an agricultural organization, so we work to
educate our local youths about conservation and
agriculture by conducting an Earth Day celebration,
where students attend presentations about
agriculture, conservation and wildlife. We generally
host over 800 fourth graders on a day near Earth
Day, and they see how the farmers who grow our
food also help care for the planet, get
demonstrations of soil erosion to learn how it can be
avoided, see many types of animals and plants and
receive educational materials plus a tree to plant.

Linux users are making their own contributions to
Earth Day by making sure that more older
computers can still be utilized longer before finding
their final resting place in a landfill.

In fact, that is part of what is behind the Reglue
Project. This project got its start as the Helios
Project, founded by Ken Starks, a long time Linux
supporter. Below (at the bottom of the page) is the
mission statement from Reglue, as displayed on
their homepage:

So, they take in computers that might otherwise end
up in the landfill, reload them with Linux, and donate
them to eligible, underprivileged children. But they
don’t stop there. They also educate these children
and their families to use their new Linux computers.

This isn’t too much unlike what many PCLinuxOS
users do. There are countless tales of how a
PCLinuxOS forum user “rescued” a computer from
prematurely landing in a landfill (often referred to as
“curb side shopping”). There are just as many tales
of friends and relatives looking to get rid of their “old”
computer (often no more than a few years old) when
they replace their “old” computer with a newer one
because it had become “too slow.” Those computers
usually “slow down” because of overly burdensome
antivirus definitions, actual viruses, or excessive
amounts of spyware, malware or crapware.
PCLinuxOS users usually get those for free or very
little cash, strip off the commercial operating system
by reformatting the hard drive, and installing
PCLinuxOS.

Much of the time, there is little to nothing wrong with
those computers, other than the original operating
system’s predisposition to hijacking by viruses,
malware, spyware, crapware and other exploits.
Once loaded up with a fresh PCLinuxOS installation
(which usually takes less than 20 minutes to do),
these recycled computers breathe a breath of fresh
air, and usually run PCLinuxOS far faster than these
computers ran their original, virus prone operating
system. Coupled with the lack of a need to run

Linux & Earth Day: Made For One Another

http://www.reglue.org/
http://www.reglue.org/
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antivirus software, the slowdown from overly
burdensome virus definitions are also avoided.

In fact, it’s not uncommon to find Linux users using
computers that are as old as 10 years old – and
sometimes even older. Unfortunately, the demise of
the availability of 32 bit Linux is going to hasten the
trip to the landfill for some of these computers that
only have a 32 bit processor. Personally, I have a

few perfectly functioning 32 bit computers that fall
into that category. Instead, I have the 32 bit version
of PCLinuxOS installed on those computers,
updated to the very last update available for 32 bit
PCLinuxOS. I plan to keep them running for as long
as possible before sending them off to become
landfill fodder by manually updating the software as
much as I am capable.

By keeping consumer electronics kept out of the
landfill for a longer period of time (which Linux users
tend to do), the problems associated with those
recycled electronics can be somewhat mitigated. If
you’re unfamiliar with the problems associated with
the recycling of consumer electronics, check out this
2010 report from NPR (National Public Radio), and
this current page from Wikipedia.

To do my part in helping to keep computers from
prematurely ending up in a landfill, I’m much more
apt to look for refurbished, used computers from
resellers found on Ebay and Craigslist than to
purchase a new unit. Not only can I get much more
value (bang) for my dollar (buck), but I can keep
these still-useful computers in use and out of the
landfills. By doing just a little homework ahead of
time to know what hardware works well with Linux
(and most computers today work perfectly fine with
Linux), I can find a perfectly good computer that will
serve me well for several years to come.

Ghanaians working in Agbogbloshie, a suburb of Accra, Ghana to recycle used, defective and out of date consumer
electronics. Often times, these used items end up in third world nations where they are salvaged without regard for the
environment. Source: WikiCommons.

Donate NOW

Linux & Earth Day: Made For One Another

http://www.gofundme.com/pclinuxos-2016
http://www.linuxquestions.org
http://www.npr.org/2010/12/21/132204954/after-dump-what-happens-to-electronic-waste
https://en.wikipedia.org/wiki/Electronic_waste
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Well well well look who's here
I want to make it very clear

If I knew you were comin' I'd 've had the blokes
Post some jokes that's no hoax

You'll find in the forum the very best folks
Howdy do Howdy do Howdy do

Had you dropped me an email I'd 've made a tape
Or a shape in Inkscape

Now that you're here you can't escape
Howdy do Howdy do Howdy do

Now I don't know where you came from
'Cause I don't know where you've been

But it really doesn't matter
If you're looking for some chatter

Let your posting begin

If I knew you were comin' I'd 've sung a song
Can't go wrong with a song

I'm inviting you now to sing along
Welcome to the PCLOS Forum

MP3 OGG

ms_meme's Nook: Welcome To The PCLOS Forum

http://pclosmag.com/html/Issues/201704/files/welcometothepclosforum.mp3
http://pclosmag.com/html/Issues/201704/files/welcometothepclosforum.ogg
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Ingredients:

• 2 Beef Filet Mignon Steaks
• 3/4 lb to 1 lb mixed exotic mushrooms such as

Shiitakes, Trumpet Royale, Maitake, Oyster,
Forest Naimeko (or more common ones like
white, crimini or portobello)
• 1 large shallot (equal to 1/4 cup when minced)
• 3 garlic cloves
• 1 tsp finely minced thyme leaves (from a small

bunch)
• 1 tbs finely chopped Italian (flat leaf) parsley
• pinch of hot pepper flakes (or more if you like

heat)
• 1/2 tsp fresh lemon juice
• 4 slices of Prosciutto
• 1 sheet of Puff Pastry (preferably Pepperidge

Farm) defrosted overnight in fridge or for 40
minutes on the counter
• 1 egg, beaten slightly with 1 tsp of water

For the Gorgonzola Sauce:

• 1 cup heavy cream
• 2 oz crumbly Gorgonzola
• 2 tbs grated parmesan
• 2 sprigs of thyme

• 1 tbs minced parsley
• freshly ground black pepper (1/4 to 1/2 tsp,

depending on how much you like pepper)
• kosher salt to taste

Directions:

Remove the Filet Mignons from the fridge a half hour
before cooking and let them stand at room
temperature. Season the fillets with kosher salt and
freshly ground black pepper (about 3/4 tsp kosher
salt and 1/2 tsp black pepper). Try to season them
evenly, getting the sides as well.

Heat 1 tbs of olive oil in a heavy bottom pan
(preferably cast iron) over medium high heat until
just smoking. Add the filets and sear for no more
than a minute on each side. You're just looking to get
the brown crust, which gives the meat so much
flavor. Leave them very rare, as they will have plenty
of time to cook in the puff pastry. Remove the fillets
from pan, turn off heat temporarily and set aside.

Wipe the mushrooms with a damp paper towel. You
don’t want to wash them because they will absorb
the moisture and make the puff pastry soggy. Finely

chop the mushrooms into uniform pieces.

Heat the same pan (don’t add any oil, you want to
evaporate as much moisture as possible) over
medium heat until nice and hot, but not smoking.
Add the mushrooms and sear until cooked through
and golden brown. Don’t stir the mushrooms initially
so they get a little brown, about 4 minutes. Then,
keep cooking and stir for another 2 minutes, season
with a sprinkle of kosher salt and black pepper.
Remove mushrooms from pan and set aside. And go
ahead...taste their glorious umami ness! I love exotic
mushrooms so much and make extra in this recipe
so I can munch on them while I cook :)

Finely chop the shallot and garlic. Mince the thyme
and parsley. Add 1tbs of olive oil and 1 tbs of butter
to the same pan and heat on medium low until butter
is melted. Add all the chopped aromatics and the
pinch of hot flakes. Cook, stirring often, until shallots
are soft. Don’t burn! Keep the heat on low if
necessary and stir often! Add the mushrooms to the
pan and season everything with a little kosher salt
and some fresh black pepper (just a few sprinkles)
and add the fresh lemon juice. Remove from heat
and set aside.

And yes, taste again. Because now the mushrooms
have even more flavor!

Lay a piece of Saran large enough to wrap a filet in
flat on the counter. Place 2 slices of prosciutto on
top, slightly overlapping. Spread half of the
mushroom mixture (or less, you don’t want it to be
impossible to wrap) evenly over the prosciutto and
place one of the filets over the prosciutto to the side.

Starting at the short end of the prosciutto slices,
carefully roll the cooked filet using the plastic wrap.
It’s ok if some of the mushrooms spill out a bit. Then

PCLinuxOS Recipe Corner

Individual Beef Wellington with
Gorgonzola Cream Sauce
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roll in the ends, trying to push the mushrooms back
into the prosciutto. Tighten the sides quite well, twist
the ends and tuck them underneath. Place the filets
on a plate and chill in the fridge at least a half hour.
In the meantime, defrost the puff pastry for 30 or 40
minutes on the counter if you haven't done so yet

Place defrosted puff pastry on a surface (preferably
a cold one) and roll out slightly. Cut in half, so the
pieces are big enough to enclose the filets.

Lightly beat one egg with one tsp of water. Brush the
egg wash around the border of the puff pastry. This
will help the dough adhere more easily.

Unwrap the filets, use scissors if you need to, and
place in the center of the pastry, aligning the long
edge of the beef with the short edge of the pastry.
Wrap one side of pastry over, roll the filet and tighten
the seam.

Trim the side ends if they are too long, or the pastry
will cook unevenly. You want the puff pastry to be
pretty much the same thickness all around.

Fold the ends in (kinda like when you wrap a
present) and pinch the dough closed.

Place the wrapped beef wellingtons on a sheet pan,
with a sharp knife cut 3 or 4 small slits on the non-
seam side. Lightly sprinkle with some flaky salt, like
Maldon. Or kosher salt will do. Chill in the fridge for a
half hour or up to 4 hours.

This is a great time to prepare the rest of the meal
and set the table!

While the Wellingtons chill, make the sauce.

Pour the heavy cream into a small pan and add the
thyme sprigs. Bring cream to a boil and quickly lower
heat to a simmer. Cook until the cream is reduced to
a thick sauce consistency as in the picture, about 7
to 10 minutes. It should leave streaks if you run a
spoon through it. Remove from heat and add the

gorgonzola, grated parmesan cheese and chopped
parsley. Season with salt and pepper to taste.

Preheat oven to 425 F. Place the sheet pan with the
Wellingtons in the oven and cook until the pastry is
golden and steaks are cooked to desired
temperature. This will take a little bit of practice to
master. Start by taking a peek at 20 minutes, but it
could take up to 30 or more, depending on your
oven. 25 to 30 minutes is usually what it takes for
me. And try not to open the oven or the heat will
escape, which slows the browning of the pastry. Let

the color of the pastry be your main guide... a nice
golden crust usually means the whole thing is done.
It's also a good idea to use a meat thermometer to
check the steak. 125 to 130 is medium rare. 140 to
145 is medium. 150 plus is well done. If you want it
well done just cook longer but lower heat to 375.

Individual Beef Wellington with Gorgonzola Cream Sauce

http://chimpbox.us
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by Jehan
Reprinted with permission, and under CC by-sa
license.
Original article appears here.

Editor’s Note: Changes made only to insure certain
language is more “family appropriate.” Otherwise, no
changes or edits were made from the original article.

GIMP is Free Software, but even before this, it is
people: the ones who create it, the ones who create
with it… We don’t have accurate statistics and we
take pride on not gathering your data. Yet we know
(through other websites that have logged partial
statistics over the years) that this is a widely used
piece of software, by millions of people around the
world. So wouldn’t it be neat to meet some of the
individuals who make this project come alive?

Some people think there’s a huge company behind
GIMP. This is not the case. GIMP has always been
developed by a handful of random people scattered
around the world. Most of them are volunteers and
none of them work on it full-time. As an insider
myself, I’ve wanted to launch a series of interviews
with the many awesome people I’ve met since I
started contributing. So who better to start with than
our own benevolent dictator, GIMP maintainer, and
the biggest code contributor: Michael Natterer, aka
“mitch”.

This interview was held on Friday, February 3, 2017
at around 3AM in front of a fireplace and after a day
of hacking at Wilber Week. With us were several
team members, including Michael Schumacher
(schumaml (S)) and Øyvind Kolås (pippin (P)), who
also asked questions.

Jehan: Hello Mitch! In a few words, what’s the close
future of GIMP?

Mitch: In 2.10, there is the GEGL port. Then the
GTK+3 port immediately after, which will go as fast
as possible. We don’t plan many features during the
GTK+3 port.

J: What are your preferred features of 2.10?

M: High bit depth, on-canvas filter previews… I don’t
actually remember the features of 2.8 [to compare]
because I never use it.

J: You use 2.10 instead?

M: Yes.

J: Do you use GIMP often?

M: Mostly for testing what I implement, and also for
making postcards I sell in my family business. That’s
the only thing I use it for.

A maintainer

J: How did you start hacking GIMP?

M: There was this code that saved the user-
assigned keyboard shortcuts for menu actions. The
code had an escaping bug where you couldn’t have
a hyphen as an accelerator. So I wrote code for
escaping the string. That was my first GIMP patch in
1997 or 1998.

J: How did you become the maintainer?

M: I killed the previous maintainer. He is now in my
cave in boxes.

Schumaml: Have you ever met the original authors
(Spencer Kimball and Peter Mattis)?

M: No. Has anyone?

S: Have they ever contacted you?

M: Yes, they sent me a few plugins which I pushed.
Neon, photocopy and cartoon. It was around 10
years after they left the project, one of them comes
to me and says “Hey Mitch, I coded 3 plugins, here
they are”. Everything looked perfect so I just pushed
them as-is, and they still exist.

These days, they’ve been reimplemented in GEGL,
but the new versions give different results, so the old
plugins are still in the menu.

J: Why do you continue working on GIMP?

M: That’s a good question. (laughs) I don’t know.
You guys, perhaps? It can be really annoying
sometimes. Why do you guys continue?

Mitch. The man. The myth. The legend.
The reason your commit probably got reverted.

An Interview With Michael Natterer, GIMP Maintainer

https://creativecommons.org/licenses/by-sa/3.0/deed.en
https://www.gimp.org/news/2017/03/01/an-interview-with-michael-natterer-gimp-maintainer/
https://www.gnu.org/philosophy/free-sw.html
https://www.gimp.org/news/2017/01/18/wilberweek-2017-announced/
https://git.gnome.org/browse/gimp/commit/?id=2d442d4842e21c45959ed73a5d9ee3896a2ada08
https://www.gimp.org/about/prehistory.html
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J: Me? It’s fun.

M: It’s fun yes but sometimes it’s not fun and you do
it anyway.

J: Where do you see GIMP 20 years from now?

M: It will probably end up in a pile of bits rotting in
some corner. I may have been thinking the same
thing twenty years ago, though, so you never know.

A hacker

J: What do you think of Free Software?

M: It’s the way to go, but you need to use the
software which is available for a task, so for some
tasks you have no choice but to use something
that’s not exactly free.

For example: [pointing to nomis trying to make a
label printer work on a GNU/Linux distribution] if you
were using the closed-source driver for that, it would
work.
*: (laughs)

J: What’s your operating system, distribution, desktop…?

M: Debian Unstable, GNOME 3.

J: You often complain about all these though.

M: Because it’s all sh*t. Just because you have the
least sh*tty [software] doesn’t mean it’s not all sh*t.
Like autotools. They are sh*t, but it’s the best sh*t
we have. There is no software that isn’t sh*t, except
perhaps the most simple of software which does one
task.

J: What’s your development environment or text editor of
choice?

M: Terminal & emacs.

J: How do you like to hack?

M: It depends. Sometimes I need silence and
sometimes a crowded room.

J: You are your own boss in a shop. But we see commits
from you all the time. Are you hacking in
your bookstore when you get free time and don’t have to
take care of your employees or customers?

M: Sometimes, but very rarely. I’m mostly hacking in
the evenings, or I commit something during the
daytime that I worked on the night before until 2AM.
If I think “I better go to sleep before I push this”, then
I’ll wait until the next day when I’m awake to check it
once more before I do.

But I don’t have time to do 5-hour long patches
during working hours.

J: You don’t sleep?

M: I don’t really sleep, no.

S: What channels do you use to communicate on behalf or
in the project?

M: IRC, and IRC.

pippin: What was the first computer you programmed?

M: It was a Schneider CPC, a variation of the
Amstrad. At 15 or 16?

S: How did you write your first hello world?

M: In BASIC of course. My programming languages
were BASIC, Assembly, Pascal, Modula-2, C, in that
weird order. :) Plus some others at university nobody
cares about. :)

J: Do you code under the influence?

M: Always! That’s the only way to code.

GIMP: present

J: So all software is sh*t, but in the list of sh*tty software,
is GIMP not so bad?

M: I hope so, but of course it’s sh*tty. We’re just a
handful of volunteers doing what companies with
hundreds of (paid) people do.

GIMPers at Montserrat, España

An Interview With Michael Natterer, GIMP Maintainer

https://xkcd.com/1782/
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J: But sometimes we do things not so bad, right?

M: Yes, but there is nobody to make sure of it. It’s
not often that someone spends the time and effort to

make a plugin perfect. Sometimes it happens, but
usually it gets dumped on us and that’s it. Ten years
later, we look at the code again and say “oh my god,
this is complete garbage”. Very rarely do people

maintain their code long term and we cannot
seriously expect that to happen with everyone being
a volunteer here.

S: Is there something you’d like to do much more in the
project, apart from coding?

M: In the project? No, coding is fun. I’m happy that I
don’t have to do that much administrative work.

S: When will 2.10 be released?

M: Oh go away! The answer is “go away!”. Read my
lips: “go away”. When it’s ready.

S: Do you expect it to be this year?

M: Yes of course.

J: So we have a promise! *: (laughs)

GIMP: future

S: There was this thing that the UI should use Python and
the core should use C.

M: Python for the user interface. Horrible! Why?

S: This is something we had discussed.

M: Yes but in the past people wanted to use
JavaScript. The year before they wanted to use
Java, the year before they wanted to use this, and
the year after they want to use that. Now they’re all
gone.

Everyone who ever said “I want to use this or that”,
and “It’s all sh*t, let’s use JavaScript”, none of them
are still in the project, so…

S: So you don’t see any big changes regarding GIMP in the
near future?

Obligatory XKCD, by Randall Munroe (Creative Commons By-NC 2.5).

An Interview With Michael Natterer, GIMP Maintainer

https://xkcd.com/323/
http://creativecommons.org/licenses/by-nc/2.5/
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M: In the near future definitely not because we need
to get some releases out. Unless, of course, there is
a well-done patch that doesn’t need weeks of
discussion and back-and-forth negotiations on how
things should be done.

About using other languages: why not? There is
Rust. There is maybe simpler stuff for doing user
interfaces, but making such decisions for a
codebase the size of GIMP is not something we can
decide based on “the latest hot stuff”.

I mean, look at this javascript mess. Is that really
better? Just because it’s easier? Easier just means
that more clueless people can write code, and they
are clueless enough already. So making is easier
doesn’t make it better. Arrogant but true.

S: Anything else you want to change?

M: Yes a lot of stuff as long as I don’t have to do all
the changes, because I really have enough things to
do already (laughs).

You can be the maintainer of whatever subpart,
please. Please. Take away the work from me. All
contributors need to realize that if they do something
really well, they will be in charge of that part.

J: That’s a very good point.

M: If you do it right, then you’ll be in charge of the
part you are doing right. It always works like that.

S: They don’t need a blessing from you, right?

M: I don’t do blessings. (laughs)

J: GTK+ comes from GIMP. What do you think of GTK+
now?

M: They lost their minds, but they are also doing
really good work. I don’t really understand some of
their decisions.

On the other hand, look at the mails we get. People
say exactly the same about GIMP: “Have the GIMP
devs lost their minds?!?”. I was involved with GTK+
for a long time and people thought that I had lost my
mind, which was (and is) probably true. Bottom line
is that all is fine between GTK+ and GIMP, I just
reserve the right to complain for myself.

S: So we will release GIMP 3 with GTK+3 or 4?

M: They just branched for GTK+ 4.x, so that’s not
going to happen overnight.

P: It won’t hurt to suddenly have GIMP 4 instead of 3.

M: No it wouldn’t. If they are done in a few weeks,
we’d go for GIMP 4 right away. So why not. That
would be cool. (laughs) Or GIMP 5!

J: GIMP 10?

M: GIMP X!

Various rants

S: If you happen to be in a conversation with people
talking about GIMP, but they don’t know that you are
involved, do you come out as the GIMP principal
developer?

M: Only if they start talking utter bullsh*t, or if things
simply need clarification. It has happened, of course.
A guy wanted to convert me to GIMP once and I had
to tell him: yeah you don’t need to. It was in a non-
hacker situation.

J: Who is Wilber?

M: Nobody knows. Wilber is a GIMP.

S: What special device would you like to see GIMP on?

M: This cool Microsoft thing (Surface Studio PC)
where they have this hyped video online, and it

looks super slick with touch and everything. It’s an
ad like Apple used to do in the past and now
Microsoft does it, which is a bit weird. The official
Microsoft YouTube video makes you want to have
one of these things.

S: What advice you would like to give to someone who
would want to contribute? What to do and what not to
do?

M: Listen to advice and be persistent.

Don’t give up because somebody says “this patch
isn’t quite right”, most of the time it won’t be. My first
commit to GIMP was reverted immediately.

S: I think you also reverted my first.

M: Yes, that’s kind of a tradition. Everybody f***s up
on their first commit and it gets reverted. That’s a
good standard.

S: So do not be afraid of errors?

M: Yes exactly. Unless they jeopardize the fate of
humanity or something. That’s unlikely.

*: Thanks for the interview.

M: You are welcome!

Mitch
at work

Images in this
article are
courtesy of
antenne, and
used by
permission.

An Interview With Michael Natterer, GIMP Maintainer
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by Paul Arnote (parnote)

If you’re anything like me, you take and have thousands of photos. Many of those
photos have been downloaded to my computer’s hard drive. Thanks to the
explosion of digital photography, it has caused us to take many pictures that we
might otherwise have not shot when using film, due to the cost associated with
having the film developed and printed into physical prints. Pocket cameras, cell
phone cameras, digital SLRs, and a whole host of other tools now put thousands
and thousands of digital photos directly at our fingertips.

Many people tend to shoot away, and edit later on the screens of their computers.
Long gone is the cost associated with having to develop and print five or eight or
12 rolls of 36 exposure 35mm rolls of film after a vacation. Now, we can edit
through all of those vacation pictures and birthday pictures and graduation
pictures, and only print out the “good ones.”

(For what it’s worth, I do not advocate printing them out at home on an inkjet
printer. Rather, you will get far superior quality by taking your digital prints to a
photo finisher and having REAL photos printed out. It’s far cheaper, too, since
inkjet prints done at home can easily cost you more than $1 each, after you take
into consideration the cost of the special photo paper and the extremely high cost
of inkjet printer inks. Compare that to the $0.29 cost you can often find at a photo
finisher. That’s a whole separate topic from what we’re going to be talking about
here.)

However, what happens more often than not, in our haste to get out the door with
our busy schedules, we end up just dumping the contents of an SD card onto our
hard drive, leaving a mess of sorts to wade through later. This can often result in
duplicate photos being stored on your hard drive. Once we get around to sorting
through the SD card dumps, it’s often difficult – if not impossible – to remember to
check for duplicate images. In very short order, it becomes a very overwhelming
task that is easier to just keep postponing.

Thankfully, there are a couple of tools to help us deal with situation this under
Linux. Mind you, while we’re primarily talking about photos here, this can also
apply to any other group of files you might have stored on your computer. Finding
and eliminating duplicate files on your computer frees up precious hard drive
space.

As you might expect, a word of caution is in order here. Before doing ANYTHING
with your precious photos (or any other files of importance to you … and they
must be important, or you wouldn’t have saved them), make sure they are
backed up (like to an external hard drive or large capacity USB thumb drive …
and verify that they are indeed backed up) before working on your original files!
Imagine how heartbreaking it would be to mistakenly delete the only copies of the
photos from your last vacation with grandma, taken the year before she passed
away. I think you get the idea.

FSlint

FSlint (short for File System Lint) came installed on my 64 bit Xfce PCLinuxOS
installation. If it is not installed on your computer, you can easily install it from the
PCLinuxOS repository, via Synaptic.

Sort & Find Duplicate Photos On Linux



PCLinuxOS Magazine Page 25

The image above is what you will see when you first launch FSlint. I changed the
search path (top fourth of the window) to only my ~/Pictures directory, since I only
ever store images from my camera and phone there. Select the “Add” button, and
select the directory where you store your photos. Then, highlight your home
directory, and select the “Remove” button.

Once you have your search path set, click on the “Find” button at the bottom left
of the window. Now, walk away for a bit while FSlint searches for duplicates.

When the search is complete, you will see a list of all the duplicate files. Under
the “Find” button, it shows that I have about 3GiB of wasted space on my hard
drive from the duplicate files stored there. Now, we could manually go through
and delete all those duplicates, one at a time, but that would take quite a bit of
time.

Fortunately, FSlint gives you some options that will speed up the process
considerably. Click on the “Select” button, and you will see the menu choices
shown above. Since FSlint collects and lists the duplicates into groups, you can
select all but the first one listed, all but the newest, or all but the oldest. Then,

once you’ve made your selection, select the “Delete” button to get rid of the
duplicates.

From the command line… fdupes

If you’d rather take care of the duplicate files from the command line, there is a
tool for that, too. The only function of fdupes is to find and take care of duplicate
files. It was not installed by default on my PCLinuxOS installation, but it is
installable from the PCLinuxOS repository, using Synaptic.

[parnote-toshiba@localhost ~]$ fdupes -rS Pictures/

The “r” switch will recurse all the subdirectories in the search directory, and the
“S” switch will show the sizes of the duplicate files. Issued exactly as I’ve issued
the command above, fdupes will only produce a list of duplicate files found in the
search path (Pictures/).

If you want to delete the files, provide the “d” switch. It will prompt you for which
files to save, and delete the rest of the duplicates. It’s just that straightforward.

For your reference, here is a complete list of the command line options (switches)
you can use with fdupes, which is just about as long as the official man page:

[parnote-toshiba@localhost ~]$ fdupes -h
Usage: fdupes [options] DIRECTORY...

-r --recurse include files residing in subdirectories
-s --symlinks follow symlinks
-H --hardlinks normally, when two or more files point to

the same disk area they are treated as non-
duplicates; this option will change this
behavior

Sort & Find Duplicate Photos On Linux

https://linux.die.net/man/1/fdupes
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-n --noempty exclude zero-length files from consideration
-f --omitfirst omit the first file in each set of matches
-1 --sameline list each set of matches on a single line
-S --size show size of duplicate files
-q --quiet hide progress indicator
-d --delete prompt user for files to preserve and delete

all others; important: under particular
circumstances, data may be lost when using
this option together with -s or --symlinks,
or when specifying a particular directory
more than once; refer to the fdupes
documentation for additional information

-v --version display fdupes version
-h --help display this help message

The command will take a bit of time to run. On the computer I’m writing this article
on (which happens to also be the one where I store most of my photos until they
are backed up), I have just under 17,000 photos stored on the hard drive. Fdupes
uses md5sum checksums to seek out duplicate files. It took fdupes approximately
five minutes to produce the list of duplicate photos. So, once you start it, go make
a sandwich. When you come back, it should be done… or at least, almost done.

The nice thing about fdupes is that even though it is a command line tool, it does
have a progress meter to show you how far it has gotten in its search for
duplicate files. Thus, you won’t be sitting there staring at a somewhat blank
screen, wondering if it is working or when it might be done. Although I can’t
imagine many instances where you might want to do so (aside from calling it from
a bash script or to run in the background), using the “q” switch hides the progress
meter. With the exception of the two aforementioned cases, I would personally
prefer to see the progress meter.

Sorting it all out… ExifTool

Now that we’ve eliminated all the duplicate photos, we now need to sort our
pictures. Sure, we could spend hours and hours doing it by hand, and if that’s the
route you choose … well, you have a lot more time than I do. But, there is a
better and easier way. Enter ExifTool.

When it comes to reading, writing, and managing the metadata stored in image
files, there simply is nothing better than exiftool. Most people associate exif data
with JPG files, but there is metadata stored in the header of many graphics files.
And exiftool is exactly what you need when you need to work with any of that
metadata.

Just running exiftool on the above image (of me and my son Ryan, during his first
bicycle ride with mom and dad when he was 11 months old), using the command
exiftool DSCF3269.JPG (run from a terminal session in that image’s directory)
yields 104 lines of metadata output.

Below are just the first 27 lines of that output:

$ exiftool DSCF3269.JPG
ExifTool Version Number : 10.36
File Name : DSCF3269.JPG
Directory : .
File Size : 4.3 MB
File Modification Date/Time : 2014:05:14 19:09:18-05:00
File Access Date/Time : 2017:03:18 16:41:25-05:00
File Inode Change Date/Time : 2016:08:02 21:55:56-05:00
File Permissions : rwxrwxrwx
File Type : JPEG
File Type Extension : jpg
MIME Type : image/jpeg
Exif Byte Order : Little-endian (Intel, II)
Make : FUJIFILM
Camera Model Name : FinePix S1500

Sort & Find Duplicate Photos On Linux
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Orientation : Horizontal (normal)
X Resolution : 72
Y Resolution : 72
Resolution Unit : inches
Software : Digital Camera FinePix S1500
Ver1.03
Modify Date : 2014:05:14 19:09:17
Y Cb Cr Positioning : Co-sited
Copyright :
Exposure Time : 1/400
F Number : 5.0
Exposure Program : Portrait
ISO : 64

While exiftool will give you much more information about your images than you
probably care to know, we can leverage this information to help us sort our
photos. To get a grasp of everything that exiftool is capable of doing, you can
view the man page by entering exiftool -h on the command line, or by viewing
the man page online, here. Be forewarned. It’s quite a long (dry) read, full of
technobabble.

So, let’s just break it down to just what you need to sort your photos from one big
amalgamated mess into something a little friendlier and easier to navigate.

exiftool -o ‘-Directory<CreateDate’ -d newdir/%Y/%Y-%m-%d -r
/olddir

(Enter the entire command above on one line).

-o tells exiftool to copy, instead of move, your images.

‘-Directory<CreateDate’ tells exiftool to make directories based on the image
dates.

-d newdir/%Y/%Y-%m-%d tells exiftool to create the specified new directories,
based on the year, with subdirectories based on year, month and day. The
“newdir” entry could be called “sorted-photos.”

-r tells exiftool to recurse directories when reading the image files.

/olddir tells exiftool where to find the images you want to sort and copy. If all of
your images are stored in your ~/Pictures directory, then that is what you’d enter
for the “/olddir” entry.

Using the “-o” switch is probably the safest way to use the command, keeping
your originals in their original location and making a copy in the new destination
directory. There may be a time, however, when you don’t have enough hard drive

space to have copies all over the place, at least until you have time to verify the
copy and delete the original. In that case, you will have to move (rather than
copy) the files to their new destination directory. To do so, just eliminate the “-o”
switch from the command.

If you’re one of those “command line shy” Linux users, there’s little I can suggest
to get you over your shyness. The exiftool is a powerful tool, and represents
probably the best – and fastest – way to sort your photos. The command can
easily be put into a very simple, barebones bash script, which can then be
accessed from Dolphin’s right click menu, or as a custom action in Xfce’s Thunar,
or as a Caja script in Mate, insulating you from having to drop to a command line
every time you want to run the command.

Summary

If you take a lot of digital photos, you can see how quickly your digital photo
collection can grow out of control, sort of like Medusa. Despite our best intentions
to keep things organized, the lack of time in our busy and demanding schedules,
coupled with the volume of digital photos that accumulate so quickly, we can find
ourselves overwhelmed in a very short period of time.

Perhaps, with these tools, maybe you can at least tame the beast. Or at least
beat it into submission. Seriously, if you were to do this periodically, I’d say you’d
be ahead of 90 percent of us in keeping your photos organized.

Sort & Find Duplicate Photos On Linux
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By CgBoy

Passwords. We all use them. Some of us only use
one password for everything. Others have many
complex passwords that are hard to remember.
Before I wrote this article, I just had a file on my
computer listing most of my passwords. Very secure,
right? Anyway, this month we're going to have a
quick look at the password managers in the
repository. I have put these in the order in which I
reviewed them.

KDE Wallet Manager. First up is KDE Wallet
Manager. Creating wallets is fairly easy. They can
use Blowfish or GPG encryption. As I do not have a
GPG key setup, I chose the Blowfish encryption
method. KDE Wallet Manager can also import and
export wallets as XML files. The user interface of
KDE Wallet Manager is good and simple. It also has
a system tray applet from which you can open and
close wallets.

Other applications like web browsers can store and
access passwords in KDE Wallet Manager. You can
see all the applications authorized to access the
wallet in the Applications tab. From there you can
also revoke authorization for applications.

So, is KDE Wallet Manager any good? I'd say it is.
It's easy to use, has a good user interface and it has
some good features, so I'd say this is a good
password manager.

KeePassX. (Note: This is version 2.0.3 of
KeePassX, not the old version 0.4.4) KeePassX is
often recommended as a good open-source
password manager. For those of you who don't
know, KeePassX is a fork of KeePass Password
Safe. When you create a new password databases
in KeePassX, you can choose to just use a master
password, use a key file, or both. KeePassX uses
either AES or Twofish encryption for its databases
(right, top).

KeePassX has a good user interface, with the
password entries organized in folders. When you
create a new password entry, KeePassX can
generate a random password for it. The entries can
be given icons too. KeePassX can fill in login forms
on websites without needing a web browser plugin.
You just need to right click on an entry and click
“Perform Auto-Type”. It will then automatically fill in
the form (right).

There are also Android and iOS apps that can use
KeePassX databases, which means you can have
your passwords with you all the time! So, what do
you think of KeePassX? I think it's an excellent
password manager. It's easy to use, has a good user
interface, and I really like the Auto-Type feature!

Revelation. The last version of Revelation came out
back in 2012, so it is a bit old. It has a nice simple

Repo Review: Password Managers
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user interface, and the password entries can be
organized into folders. The password database is by
default an XML file using AES encryption, but it can
also use LUKS encryption. Revelation can also
import from, and export password databases to
many other formats.

Revelation also has a search function. There's a
password generator, and a password strength
checker tool. Unfortunately, Revelation does not
have an Auto-Type feature like KeePassX.

So, how well does Revelation work? Although it's not
as advanced as KeePassX, in some ways I like
Revelation more. It has a great user interface that's

easy to use. But I do wish that it had an Auto-Type
feature like KeePassX.

Pass. Unfortunately, I had so much trouble trying to
set up Pass, and trying to set up a GPG key, that in
the end I couldn't get it working properly. So, I'm just
going give you a basic overview of Pass. Pass is a
command-line password manager. Instead of storing
all the passwords in one database, it stores them
each in separate GPG encrypted files. Those
password files are then stored in a simple directory
tree structure.

There are scripts that allow you to import passwords
from other software into Pass, including scripts for
KDE Wallet Manager, KeePassX, and even
Revelation. There are also plenty of GUIs for Pass,
and there are even Android and iOS apps.
Unfortunately, there aren't any Pass GUIs in the
PCLinuxOS repository.

There are even web browser plugins for Pass. Along
with all that, Pass also has a built-in password
generator. So, is Pass a good password manager?
Well, I don't really know, as I couldn't get it to work
right. It does appear to be a pretty powerful
password manager, but at the same time, it doesn't
look like it's very easy to use.

GNOME Keyring. I didn't even know exactly what
GNOME Keyring was until the day before I had to
submit this article. GNOME Keyring is a command-
line password manager. And it uses AES-128
encryption. I actually don't know much about
GNOME Keyring. I couldn't even figure out how to
use it...

Other applications can access and store passwords
in GNOME Keyring. And there are also GUIs
available for it, but unfortunately there aren't any in
the PCLinuxOS repository. Because I didn't have
time do a full review of GNOME Keyring, I'm not
sure if it's a good password manager or not. Sorry.

Summary

Well, we're at the end of the article already. So, out
of these five password managers, which is the best?
I think I'd probably say KeePassX was the best. It's a
good program with some great features. However,
my favorite is actually Revelation. I really liked its
simple user interface. KDE Wallet Manager is all
right, but it's not my favorite. I never could give Pass
and GNOME Keyring full reviews, so I don't exactly
know how well they work.

A magazine just isn't a magazine
without articles to fill the pages.

If you have article ideas, or if you
would like to contribute articles to the
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pclinuxos.mag@gmail.com
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by Meemaw

In part one, I introduced you to the Create Tiled
Clones window and a few simple things you can do
with it. Now I will show you a few things you may
have already seen with this tool. Many of the
settings I report can be changed to suit yourself.
Also, if you have clones and decide that you want to
clone the same object again, you can use any of
them. However, if you decide to delete some and
delete a clone that you have used to clone more, all
if its clones will be deleted as well. To find the
original, all you need to do is choose one (in the
status bar, it will say “Clone of Image (size of
image)”, then press <CTRL> + C and you will see a
line extend from your choice to the original.

OK, more examples:

In the 100th issue of the PCLinuxOS Magazine,
May 2015, our cover featured one of Georgetoon’s
awesome cartoon characters with a cake and
confetti in the air. The confetti was made using the
Create Tiled Clones tool.

First, I made some little confetti pieces… diamonds
and squares, one of each in three different colors.
Using each one alone, I opened the Tiled Clones
window and changed the settings as shown below.
All settings were entered in the Randomized
columns.

Shift 85% - Scale 25% - Rotation 50% - Blur 30% -
Opacity 40%

In part 1 of this article, I gave you rows and columns
for the limits of the clones (bottom of the window) but
on this, I used 7” x 5” width & height.

This also worked for the stars on the cover of the
October 2014 issue. However, the settings were
different.

The St. Patrick’s Day, March 2015, magazine cover
featured a mess of shamrocks. I started with a
shamrock background (below, right), but I wanted
more shamrocks, so I used a different, single
shamrock and cloned it.

All Randomized … Shift 85% - Scale 25% - Rotation
50% - Blur & Opacity 0%

I selected all and moved the clones over the
shamrock background and added Tux and his hat
(parnote always adds the panels with the article
titles).

Also, the checkerboard mentioned in part 1? Do it
this way (next page):

Inkscape Tutorial: Create Tiled Clones, Part Two

http://pclosmag.com/html/Issues/201505/links.html
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Draw four squares, filling two with black and two with
white, and all with a .25 black stroke. Depending on
how you have your preferences, you can “snap”
them together, or use align and distribute so that
their edges are touching. Select all four squares and
click Group. They should look as shown below.

Now, open the tiled clones window. The first thing
you should probably do (if you’ve been
experimenting) is reset all settings to zero by clicking
the Reset button at bottom left. Now change the
settings at the bottom of the window so you are
making 4 rows and 4 columns. Leaving all other
settings at zero, click the Create button. And, there
you go….

In the next tutorial, we will experiment with clones
that may not necessarily result in rows and columns.

Screenshot ShowcaseScreenshot Showcase

Posted by ms_meme, March 6, 2017, running KDE.

Inklscape Tutorial: Create Tiled Clones, Part Two

http://www.opensource.org/
http://www.linuxforum.com
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by phorneker

PCLinuxOS has an abundance of applications and tools for audiophiles, disc
jockeys, musicians, music producers, composers and anyone else involved in
working with music.

On my laptop, I have aTunes, Clementine, Audacious and Deadbeef for music
players. For editing, I have Audacity (the gold standard in audio editing
applications), Mixxx and ReZound. When installed together, anything is possible
when it comes to audio production.

My music collection is quite diverse, not only in terms of genre, but literally spans
decades (from the 1960s to the current decade).

The idea of remixing music to create new pieces of music is no different from
creating a fork of an application running on PCLinuxOS, composing a new
photograph by manipulating elements of one or more original photographs, or
even creating a new entree from leftovers in the refrigerator. The success of Free
and Open Source software and Creative Commons licensing is attributed to this
very concept, and is also a reason why we need to keep this concept going long
into the future. Vaporwave is a very short lived example of an idea of remixing
music.

Vaporwave

According to Wikipedia, the genre of vaporwave is defined as:

“an electronic music subgenre that originated in the early 2010s and spread over the next
half of the decade among various Internet communities. It is characterized by a nostalgic
or surrealist fascination with entertainment, technology and advertising of the 1980s and
1990s, and styles of both corporate and popular music such as lounge music, smooth jazz
and elevator music.”

One could argue that vaporwave is a derivative of most music produced over the
past century, in the sense that such music is manipulated in ways such that what
is created is completely different from the original. But this definition can also
apply to turntablism (which took its present form in the late 1970s), house music

(which started in the early 1980s in Chicago), and chopped and screwed (which
started in the early 1990s).

While vaporwave compositions are slowed down in nature, the term vaporwave is
derived from the term vaporware, that is any commercial hardware or software
products that once were concepts but were never made available to consumers.

Anyone can produce vaporwave compositions. All you really need is Audacity (or
ReZound) and a way to get your music into your PCLinuxOS machine. It is must
a matter of slowing down each track you include in that composition. It is also a
matter of making the result as aesthetically pleasing as possible.

Because vaporwave is derived from so many genres of music, you could
arguably use most any composition created since music was first recorded. Much
of what the vaporwave compositions I hear (through YouTube) is derived primarily
from commercial (read copyrighted) music. In this sense, vaporwave is a strong
criticism of the capitalist system.

I am no expert on copyright law, but there is an obvious issue here, namely that
of copyright. However, I see where these artists are coming from, and their right
to free expression. After all, there is a reason why we use PCLinuxOS in the first
place.

When it comes to popularity, vaporwave is a short lived genre. Just as
breakdancing came and went in the early 1980s (I used to breakdance at that
time at the high school dance in 1984 and 1985.), vaporwave came and went just
in the past few years of this decade.

My Experiments

What I have been doing with music, is quite similar, in the sense that it is free
expression. However, I choose to use Creative Commons licensed music and
sound clips (including those published in this magazine) to create my
compositions. By using CC and other compatible licensed material (including
public domain), I do not have to worry about the legal and/or ethical ramifications
of using such material.

Experiments In Music With PCLinuxOS
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Some background regarding the experiments

Back in the 1970s, one of my curiosities was to see what a record would sound
like if it was played at the wrong speed. (How many of you have had that
curiosity back in the day?)

When playing a 33 rpm (or 45rpm) at 78 rpm, I called that “Chipmunk” music,
named for the musical group The Chipmunks created by music producer Rostom
Sipan "Ross" Bagdasarian (better known as David Seville), of which the voices
were recorded at a slow speed then played back at normal speed.

In contrast, playing a 33 rpm or 45 rpm record at 16rpm (the speed of a Seeburg
1000 record) produces a low and slow voice that I call “bear music” to simulate
the “voice of a bear.” However, playing a 45 rpm record at 33 rpm (and vice
versa) can produce a better than intended effect on the music.

For example, playing Dolly Parton’s “Jolene” (a 45 rpm record) at 33 rpm sounds
like Neil Young singing “Jolene”. Likewise, some DJs played Herb Alpert’s “Rise”
(the title track on 33 rpm) at 45 rpm, and it sounded just a great as the original
(only faster).

Reel to reel, cassette decks, and 8-track recorders/players (for those of you who
remember that far back) can and do eventually malfunction. When they do,
playback of those tapes will produce unexpected effects ranging from tape
playback wavering in pitch and speed, to the actual tapes wearing down and
producing muffled sounds coming in and out, and in the worst case scenario,
tapes being chewed up by the player.

To think that what was once tragic and expensive (and sometimes laughable) is
now considered cool and artful. We can give thanks in part due to YouTube
videos containing such content, and thanks in part due to new trends in music
developed since the 1980s, where such trends involve repurposing of older
music, in the form of remixes, scratching, beat juggling, beat matching, cutting,
reversing, slowing down, speeding up, back spinning and chopping of music. Of
course, this does not work for every piece of music, and to manipulate music in
that manner at that time would lead to expensive repair bills on such equipment.

A notable exception can be found in the movie High School High, where in the
school dance, the disc jockey scratched up Glen Campbell’s Rhinestone Cowboy.
That song suddenly gained popularity because of the scratching.

Thanks to applications such as Mixxx, Audacity and ReZound available in the
repository, the effects from such music manipulation can now be simulated
without having to take your high fidelity equipment to the repair shop.

ReZound

This audio file editor is just as good as the gold standard (Audacity) and is
available in the repository. There are some things you can do with audio files
using this that are difficult to do in Audacity, namely:

* Simulate a malfunctioning tape player
* Start or stop a turntable with the needle still on the vinyl
* Simulate a tape being chewed up

This editor has a function called Curved Change Rate, and is accessed from the
Effects menu. With a sound clip loaded into ReZound, simply select Effects →
Curved Change Rate, and a dialog box pops up with a graph. It is here where
you graphically select points within the audio file where changes to the playback
rate are indicated.

For this example, I have ms_meme’s “PClololos” loaded into ReZound. The
original published track was recorded as a 22050 Mhz mono track. I remastered
this composition as a 44100 Mhz stereo track.

Now let us open the Effects menu.

Experiments In Music With PCLinuxOS
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As we can see here there is a good selection of effects we can use on audio files.
Change Rate is used to manipulate the playback speed of the entire audio file,
whereas Curved Change Rate provides a fine tuned method where parts of the
audio file are played back at different speeds within the same audio file. It is here
where the magic begins.

The graph in this dialog box affects the selection you are currently editing. Simply
draw your graph inside the waveform shown. There are four buttons. The leftmost
clears out the graph to a straight line. The middle two widen and lengthen the
view of the selection respectively. The rightmost button automatically creates a
smooth curve based on points you have selected in the graph shown below.

You may also save your selections as a preset (by clicking on Save), then reuse
the selection (with Use, replacing what is already in the graph) on another
selection or track.

The following below is an example of what you can do with Curved Change Rate.

You can simulate a malfunctioning tape player by varying the playback of the file
in a way that the audio slows down and speeds up at random moments

Experiments In Music With PCLinuxOS
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throughout the playback. This simulation is graphically represented (as shown
here) by randomly placing points on the graph window representing the audio file
so a random waveform is displayed. Click on the right most button to create the
smooth curve used for the simulation. Then click on OK to warp the audio file.

Likewise, you can simulate starting up a turntable with the needle on the record
by placing a point at the beginning of the graph representing a playback rate of
zero. Then add some points in ascending order so you create a ascending curve
that reaches the normal level.

Simulating stopping of a turntable is done by creating a descending curve from
normal to zero in the graph.

The sharper the curve, the quicker the effect will be when the audio file is played
back. Likewise, the longer the curve, the longer it takes for the effect to be
produced. This is useful if you want to simulate gradual stopping of a record on
the turntable.

If you create a waveform, and then end the graph with a zero point at the end of
the file, you can simulate the tape player chewing up the tape.

...and if you want to look for subliminal messages in this file, selecting Effects →
Reverse will reverse the audio file, so when you play the file, it will play
backwards.

Change Volume and Gain options can be used to fine tune the playback volume
of the audio file. Curved Gain allows you to adjust the volume on parts of the
selection or audio file, rather than the entire selection or file.

Mixxx

Just what the name says. It is a virtual DJ console that does most everything the
commercial product (read as expensive) Emulator 2 by Touch Innovations can
do.

Mixxx can be installed from the repository, and once you start using it, you could
imagine the possibilities of what you could do to your music.

Before we get further into Mixxx, let us define some terms about music
manipulation.

* Sample: A sample is a selection of audio generally short in length, but is used
to define a sound as a musical instrument. That sound could be anything from a
drum beat, to parts of Donald Trump’s speeches, to cows mooing.

* Scratching: The act of rapidly moving forward and/or backward digital audio
while that audio file is playing, usually in a rubbing motion or sudden movement
in either direction, the idea being to make that audio a musical instrument.

* Cutting: The act of playing a sample on a turntable or CD deck, then pausing
the audio at the right time. Usually, the audio to that turntable is cut off first, then
the audio is reversed to the start point. At that time, the audio is restored, and the
process is repeated. For example, I took a sample of Donald Trump saying
“Great People” and morphed it into “Great People, Great People, Great, Great,
Great People.”

* Beat Juggling: What you are doing when you have two turntables (or CDJ
decks) with the same music track loaded into each, cued up to the same point.
With the crossfader at one end, the sample is played. At the end of the sample,
the sample on the other turntable is started while you quickly move the
crossfader to the other side, at the same time reversing the first sample to the
beginning. At the end of the second sample, the first sample is started again, and
the crossfader quickly switched to the other side on the mixer. Switching the
crossfader quickly simulates a switch between the two turntables (or CDJ decks).
The result is only the samples play in a fashion that resembles juggling, hence
the term beat juggling.

* Backspinning: What you do when you quickly reverse a track while it is still
playing. Likewise, quickly forwarding a track while the track is playing is called
Forwardspinning.

* Reverse Playback: While not an official DJ term, it is what is accomplished
when you click on the reverse button (next to the Play/Pause button) while the
track is playing.

Experiments In Music With PCLinuxOS
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Mixxx comes with the following features:

* Two to four simulated turntables are available (with two turntables available
being the default when Mixxx is launched)

* Four sampler decks are available, not enabled by default.

* Two preview decks (only available when two turntables are active, instead of
four), not enabled by default.

* Vinyl simulation is either Serato, Traktor or MixVibes style, and scratching is
done with a DJ controller (simulating a turntable) or a mouse.

* Skinned themes with different control positions. Default here is called Late Night
and resembles the Emulator 2 product.

* Ability to broadcast live through a Internet stream

* Ability to record mixes

* Configurable repository of music

For this configuration, I have two virtual turntables configured Serato style for
turntablism, four samplers for adding looping beats to the mix, and a repository of
music stored on the hard drive.

Music Sources

Freesound.org and ccmixter.org are two websites I like to visit for audio samples
to use.

Archive.org has a large repository of music as well as audio clips. Think of
archive.org as the public library on the Internet where you can access most
anything that can be found on the Internet. (I have accounts with all three
sources.)

Attention K-Mart Shoppers!

If you have ever been in a K-Mart back in the 1970s through 1990s, much of the
background heard in the store can be found at
https://archive.org/details/attentionkmartshoppers.

These digitized tapes average two hours in length, and is best downloaded to
your local machine rather than streamed (especially if you have a low bandwidth
connection). Downloading allows you to enhance the music for better enjoyment,
as well as divide the track into individual tracks you can play separately.

Also, the licensing of the taped to K-Mart called for destruction of the tape after
the time period for which the playback tape was assigned had expired.
Thankfully, this directive was not followed, or the music would not be available for
our enjoyment today.

Also included in this collection is a single tape (digitized from a reel to reel tape
deck instead of cassettes from this collection) from 1973 which starts with the
classic K-Mart jingle at that time. The music on this tape is the same type of
music heard on the Seeburg 1000, whereas tapes produced in the 1980s and
1990s contained popular music of that era. There is also a Christmas 1978 tape
containing the standard K-Mart advertising spots as well as special messages
such as “Security to Section 3 please” designed to deter shoplifting.

Seeburg 1000 Update

Shortly after I wrote the last article, seeburg1000.com upgraded its servers and
again changed the access URL to http://74.82.59.197:8351/stream.

The best way to keep up with the changes is to go to seeburg1000.com, click on
Click to Play, then where it says Click on your favorite media player’s logo, click
on the first icon (representing Winamp), and allow your web browser to download
playlist.pls and then launch the media player assigned to your web browser.

Experiments In Music With PCLinuxOS
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For the official PCLinuxOS releases, that default
player is Clementine.

Like PCLinuxOS itself, their online store,
http://seeburg1000.bigcartel.com/ has merchandise
for purchase, of which proceeds fund the operation
of the website and the playback of the music library.
Merchandise includes apparel, CDs, and a vinyl
record of Seeburg music.

Seeburg1000.com merchandise can also be found
on eBay for purchase. If you are lucky enough, there
might be a real Seeburg 1000 machine for sale.

The website located at
http://www.nixiebunny.com/seeburg/ contains 10MB
files of digitized Seeburg records available in MP3
format. The files here represent a small sample of
what was available for the Seeburg 1000.

The aforementioned sources are some of the music
vaporwave artists used as the base for their
creations. In theory, most any music ever recorded
was fair game for this practice.

The experiments I worked with for this article go
beyond the concepts of vaporwave and house
music. Once you start using these tools for audio file
manipulation, imagine the possibilities of what you
can do.

Screenshot ShowcaseScreenshot Showcase

Want to keep up on the latest that's
going on with PCLinuxOS?

Follow PCLinuxOS on Twitter!

http://twitter.com/iluvpclinuxos

Posted by parnote, March 28, 2017, running Xfce.
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As told to YouCanToo

What is your name/username?
My name is Logan/jake721

How old are you?
Currently I am 80 years young and will soon add 1
more to that.

Are you married, single?
I am married. My wife Patty and I have been married
for 25 years.

How about Kids, Grandkids ?
Between the two of us we have 3 sons and 6
grandkids, 3 boys and 3 girls ranging in age from 13
to 33.

Do you have pets, what is your favorite?
We have no pets, mainly because we have traveled
a lot but if we were to get one it would be a dog.

Are you retired, still working and if working, what
do you do?
I have been retired for nearly 21 years after a long
career with a pharmaceutical company. I was in the
research area, involved with biological testing of
potential new drugs and later in the quality control
laboratory, doing micro-quantitative analysis. Most of
my last several working years were spent setting up,
maintaining and sometimes troubleshooting
analytical instruments while trying to help others
solve those inevitable glitches that crop up from time
to time.

Where do you call home? What is it like?
IE: weather, scenery
I live in Evansville, southwestern Indiana where we
have all 4 seasons of the year. We get some snow in
winter and in summer it is hot and humid. Spring and
fall are usually pretty nice. The terrain is somewhat
flat with low rolling hills and adjacent to the Ohio
river. The rural areas are farmland, mostly producing
corn and soybeans.

Where did you go to school and what is your
education level?
I graduated from Bosse High School, spent one
hitch in the U.S. Navy and enrolled in some night
classes at the local university, but never completed a
degree.

What kind of things you like doing? hobbies,
travel, fishing, camping?
We enjoy traveling and in our 25 years together
have been busy visiting all 50 states. In addition we
have visited Australia, England, Ireland and
Scotland, with a 1 day junket to Paris while we were
in England. I am a licensed, Extra Class, ham radio

operator since 1971, with the call sign N9LJ but I
am not nearly as active as I once was. I also enjoy
bowling which I have done for many years.

Why and when did you start using Linux?
My first experience with computers was with an IBM
PC at my workplace in 1982. I later had my own
Timex-Sinclair 1000 and then graduated to an ATARI
800XL before the PC era really bloomed. My first
interest in Linux was spurred by Leo LaPorte and his
TV shows on the old ZDTV channel. I have always
been a bit of a DIY, tinkerer type and Linux loomed
as a new adventure for me. Over the next few years
I tried a number of distros, the first being Red Hat on
a disk I copied from a CD in a library book. Then I
began a quest for a version I could better
understand but I honestly didn't give most of them a
fair chance. Mandrake Linux, I think version 7 or 8,

Reflection of the city skyline on the Ohio River.

Taken while on tour in Ireland with the Cliffs of Moher
in the background.

PCLinuxOS Family Member Spotlight: jake721
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was the first one I found that I got into at all. That
was my very first actual Linux install to a hard drive.
Then I came across PCLinuxOS and downloaded
P.93 Minime, which I played with for a while but
never really got going with it. All this had been
experimental rather than progressing toward a goal.
I had been reading the online PClinuxOS magazine
since its beginning. When I went with PCLinuxOS
2007, it all began to make more sense to me, and
my interest grew. Even so, with all the
improvements, it took the 2009 distro to finally pull
me in. Now, here we are today. Plus, I want to say
how much I enjoy the forum with all the
knowledgeable, friendly and helpful members who
are so willing to assist anyone who asks. Also a big
THANKS to Texstar and the gang for keeping us up
to date and running with PCLinuxOS.

What specific equipment do you currently use
with PCLOS?
My main computer with KDE is built on a Gigabyte
GA-MA770T-UD3P, AMD Phenom II X2 550, 4GB
RAM, ASUS GeForce GT 440 (Silent), 500 GB
Seagate HDD and ASUS DVD/CD burner. Patty's
machine is similarly equipped, built on a Gigabyte
GA-970A-UD3, AMD Phenom II X4 965, 8GB RAM
and dual boots Win7/PCLinuxOS KDE while I try to
win her over to the Linux side. There is also an older
Toshiba laptop with Mate 32bit, which will be
replaced very soon due to its obsolescence.

PCLinuxOS Family Member Spotlight is an exclusive,
monthly column by YouCanToo, featuring PCLinuxOS
forum member. This column will allow "the rest of us" to
get to know our forum family members better, and will
give those featured an opportunity to share their
PCLinuxOS story with the rest of the world.

If you would like to be featured in PCLinuxOS Family
Member Spotlight, please send a private message to
youcantoo, parnote or Meemaw in the PCLinuxOS forum
expressing your interest.

PCLinuxOS Family Member Spotlight: jake721

Screenshot ShowcaseScreenshot Showcase
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Posted by PendragonUK, March 20, 2017, running KDE.
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Log right in look up and down

Honey get yourself aligned

Log right in look up and down

Don't get left behind

Everybody's talking 'bout

A new way of computing

It will really blow your mind

Log right in look all around

Texstar will never let you down

Log right in look all around

Honey you will love what you find

Log right in look all around

PCLOS is well designed

Everybody's talking 'bout

A new way of computing

It will really blow your mind

Log right in look all around

Got the best forum in town

MP3

OGG

ms_meme's Nook: Log Right In

http://pclosmag.com/html/Issues/201704/files/logrightin.mp3
http://pclosmag.com/html/Issues/201704/files/logrightin.ogg
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Editor’s Note: Tip Top Tips is a monthly column in The
PCLinuxOS Magazine. Each month, we will feature – and
possibly even expand upon – one tip from the PCLinuxOS
forum. The magazine will not accept independent tip
submissions specifically intended for inclusion in the Tip
Top Tips column. Rather, if you have a tip, share it in the
PCLinuxOS forum’s “Tips & Tricks” section. Your tip just
may be selected for publication in The PCLinuxOS
Magazine.

This month’s tip comes from PCLinuxOS forum
member corazon.

(Written to include people who have never used the
audio tools in PCLinuxOS, starts out dry, but
hopefully gains momentum, holds interest, and
inspires some experimentation.)

Run the command

groups

If the audio group is not listed, use PCC to add
yourself to that group.

Edit the text file /etc/security/limits.conf. It should
conclude with these lines:

@audio - rtprio 99
@audio - memlock unlimited
@audio - nice -10

(For luck, use the same spacing as exists in your
existing file).

Install and start qjackctl. (There are many youtubes
to visualize using qjackctl, as written below.)

Install and start amsynth.

What is my soundcard or chip called, in qjackctl
setup panel? Run the commands aplay -l and
arecord -l.

The items in the terminal output within brackets are
your soundcards/chips. In the qjackctl setup panel,
click the widgets to the right of Input Device and
Output Device, and choose or fill in the title found
within brackets.

If you lack a midi keyboard to play notes, you can
use qwerty keyboard input. Install vkeybd and start it
with vkeybd --octave 6 (or 8, etc.).

It will appear in the ALSA tab of the qjackctl
connection panel, on the left side. Connect it to your
amsynth on the right side. To make connections, you
select an item on both the left and right sides, and
press the Connect button, and a line will draw
between them if it's a valid connection option.

For another easy soundsource, install qsynth GUI
for fluidsynth, and fluid-soundfont-gm. This will give
you a collection of sampled common pop-orchestral
sounds.

You can also cable in any instrument that has a line-
out or headphone out, to your computer audio input,

Tip Top Tips:
Chaining Sound Effects With Rakarrack

http://www.pclinuxos.com/forum/index.php/topic,139272.msg1189802.html#msg1189802
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(usually the green jack is the audio input, when
motherboard sound is used) Most yamaha, casio,
and similar rompler style keyboards work fine.
Second-hand stores often have some very cheap,
as well as craigslist, ebay, etc.

When you have an instrument working, install
rakarrack, and start four (4) instances of it. You can
resize and place the windows so that the main
sliders and preset title are all visible, or just put them
on multiple desktops.

Note that there is an on/off checkbox in the upper
left of both the main rakarrack panel, and each of
the individual effects panels, and that many of the
individual effect panels have some useful presets in
a menu at the upper right.

In each rakarrack, in it's preferences for jack,
uncheck the autoconnect boxes, and make sure
none of the system:capture or system:playback
entries is highlighted. (This provides a blank
connection slate to start with).

For this example, use these rakarrack presets in
order (all from Bank 1) in the four rakarracks:

Metal Tone i/o at -13 and -9
Summer At The Pit at -13 and -6
Clean Swirl at -9 and 0
Jet Flanger at -17 and 12

In Summer At The Pit, in the Echotron panel, I chose
from the menu in the upper right, 'Ambience'. (The
default has a delay effect I didn't want, in this case).

In Clean Swirl, look at the Analog Phaser panel. It
has a tempo control. I slow it down to six (6). To gain
a slow subtle filter sweep, type influence.

Remember you select an item on both the left and
right side of a qjackctl connection panel, and press
the Connect button, and a line will draw between
them if it's a valid connection.

The connections below will route your chosen sound
into the first effect, the effected sound into a second
effect, and those effected sounds into a third effect,
which goes to your audio output, building the amp
gain, and adding modulations and distortions along
the way.

And then, the original sound goes by itself into a
separate fourth effect.

Choosing a variety of input sounds will display the
versatility of the effects, and you can start a list of
combos you like. Here are the connections for an
emotive moving distortion, that gives a whole new
life to some sounds, but once 'you're in' there isn't
much that can't be done, and both extreme sublety,
and extremism can be rewarding

-------------------------------------------

In the qjackctl connection panel, under the Audio
tab, connect:

amsynth on the left to rakarrack on the right (Metal
Tone)

rakarrack on the left to rakarrack 01 on the right
(Summer At The Pit)

rakarrack 01 on the left to rakarrack 02 on the right
(Clean Swirl)

rakarrack 02 on the left to system on the right (your
sound output)

amsynth on the left to rakarrack 03 on the right (Jet
Flanger)

rackarrack 03 on the left to system on the right (your
sound output)

------------------------------------------------

What if it's too quiet or too loud, or too noisy?

Each rakarrack has a pair of stereo sliders, the one
on the left is the (dry) input signal, the one on the
right is the (wet) effected signal. In this example,
there can be a lot of noise, mainly undesired, but
you can adjust that away, by using these i/o
(dry/wet) sliders to control the levels of each
rakarrack. Your tastes will differ from mine, and
experiments can find sonic jewels.

For simple recording of your experiments and
masterpieces, install and start Timemachine, a
simple one-button recorder, then in qjackctl audio
panel, connect the original sound, the summed third
effect, and the fourth effect, (all on the left) to
Timemachine on the right. Timemachine has a level
meter, and shows any clipping in red. Press the
record button, and it turns orange while recording.

Import the timemachine .w64 or .wav file into
audacity for editing, and export to mp3, ogg, etc.

Looking for an old article?
Can't find what you want? Try the

PCLinuxOS Magazine's
searchable index!

DOWNLOAD

Mate Desktop

Tip Top Tips: Chaining Sound Effects With Rakarrack

http://pclosmag.com/htdig
http://www.dosgamesarchive.com/
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SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
tiles with which to make as long of a word
as you possibly can. Words are based on
the English language. Non-English
language words are NOT allowed.
2. Red letters are scored double points.
Green letters are scored triple points.
3. Add up the score of all the letters that
you used. Unused letters are not scored.
For red or green letters, apply the
multiplier when tallying up your score.
Next, apply any additional scoring
multipliers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your tiles in a set to
make your word. You will not necessarily
be able to use all seven (7) of the letters in
your set to form a “legal” word.
5. In case you are having difficulty seeing
the point value on the letter tiles, here is a
list of how they are scored:

0 points: 2 blank tiles
1 point: E, A, I, O, N, R, T, L, S, U
2 points: D, G
3 points: B, C, M, P
4 points: F, H, V, W, Y
5 points: K
8 points: J, X
10 points: Q, Z

6. Optionally, a time limit of 60 minutes
should apply to the game, averaging to 12
minutes per letter tile set.
7. Have fun! It's only a game!

SUDOKU RULES: There is only one valid solution to each
Sudoku puzzle. The only way the puzzle can be considered
solved correctly is when all 81 boxes contain numbers and the
other Sudoku rules have been followed.

When you start a game of Sudoku, some blocks will be prefilled
for you. You cannot change these numbers in the course of the
game.

Each column must contain all of the numbers 1 through 9 and
no two numbers in the same column of a Sudoku puzzle can
be the same. Each row must contain all of the numbers 1
through 9 and no two numbers in the same row of a Sudoku
puzzle can be the same.

Each block must contain all of the numbers 1 through 9 and no
two numbers in the same block of a Sudoku puzzle can be the
same. D

o
w
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u
zz
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lu
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s

H
er

e

Possible score 189, average score 132.

PCLinuxOS Puzzled Partitions

http://pclosmag.com/html/Issues/201704/files/2017-04-PuzzleSolutions.pdf
http://www.scrabblesite.com/scrabble/rules/
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altocumulus altostratus

anemometer barometric pressure

chinook wind cumulonimbus

cumulus hurricane

hydrosphere hygrometer

inversion isobar

mammatus cloud meteorology

nimbus nimbostratus

orographic cloud parhelion

permafrost pileus cloud

rope tornado squall line

stationary front St. Elmo's fire

stratosphere stratocumulus

stratus thunderstorm

tornado alley tropical depression

twister typhoon

vortex wall cloud

waterspout

X K O O J O W M V G D U D T X Y U M C R O P E T O R N A D O
G F Z S T E L M O S F I R E I Y V D H P A O T K E S U N X M
M S Z D P Q F X Y T D G C R A R X Q Y H N G F B C D U V L A
R N E T V R S U Z S U L U M U C O T A R T S R A L F J G H T
O I G U T H I Z G Q L O C N R S T A T I O N A R Y F R O N T
T U W Y A B S E E N A C I R R U H C Y E L L A O D A N R O T
S O S V F L N A B G J B N R E R K U E R E T E M O R G Y H X
R I L E C Z T E Y X Z U B Y X G K S Z W P Q S E P J L H G E
E T R H Y D R O S P H E R E V Q K M G M K Y D T D S T G S Z
D N E W T S F E C D W O C D R K C V P L K P A R H E L I O N
N G N N R O D H O U L X U G B N O I S R E V N I E C W A L L
U Q L G O Q U L Z L M O M T Q Z B U G Z S D Y C A K P H T I
H J O U P P O O Y Y L U U T Y P H O O N J N I P H K B Q N Z
T C N Y I C L R C C V Z L M C G Q Y J V X S J R R S T T G N
Z M B G C V C O E W B N U U I G P A F J U H S E V Z S H R Q
C E V O A K S G T Q P H S M S Q F Q E T G Y T S K Y U Y K X
Z W M L L O U R O F D Y J P C D D L A D K S A S C F B J C C
H P Q O D X T A G E I D Y C Z K B R C R I I J U O N M H N V
R E A R E D A P M H V O G O I D T E J W A I R R L L I D G N
W R I O P X M H Y D J V Z R S S S T T K V T Q E L N N W Y I
M M D E R X M I G L N R W D O U L E W X E H Y V O Y O A H M
E A E T E T A C D V A S M T B N A M L T T P F O K V L H Z B
R F B E S E M C F Z M Q L M A Q W O U P E I K E R B U H R O
P R N M S U U L F P Q A I B R N T M O B E W L I T G M T Z S
P O F R I I L O S H C N P M Z W H E L W I T R V G D U I Q T
K S T W O J E U L T N J Z O O H D N C N L U P Y O I C Q H R
P T W E N Q S D A Q Q M L Y I M Z A D D B Y V T F R O K P A
Y M E F O U Q D U O L C S U E L I P J X X W B L A J T H F T
A S Q U A L L L I N E Z I J F V H T U O P S R E T A W E V U
S T R A T O S P H E R E C S Q I C W S C W R E C Q S X Z X S

Download Puzzle Solutions Here

PCLinuxOS Puzzled Partitions

PCLinuxOS Word Find: March 2017
Weather

http://pclosmag.com/html/Issues/201704/files/2017-04-PuzzleSolutions.pdf
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1. a device that measures wind speed
2. an atmospheric condition that looks like

bright spots to the left and right of the sun.
3. two air masses, neither of which is strong

enough to push the other out of the way
4. a hurricane which occurs in the

northwestern Pacific Ocean
5. also called a thunderhead, can cause

lightning, thunder, hail, strong rains, strong
winds, and tornadoes

6. the area in the central United States where
the majority of tornadoes occur

7. tornado formed over the water
8. same as a tornado
9. meteorological term applied to a cellular

pattern of pouches hanging underneath
the base of a cloud

10. low altitude clouds that are small, puffy,
patchy and/or with a wavelike appearance

11. an atmospheric condition where glowing
light seems to appear on tall structures
during a thunderstorm

12. a device that measures humidity
13. low altitude clouds, they are uniform,

dark, flat, low, featureless clouds that
produce precipitation

14. the study of atmospheric conditions
15. low altitude clouds, that look puffy and

piled up
16. a definite circulation slower than 34 mph

(63 kph) that may turn into a hurricane

Download Puzzle Solutions Here

PCLinuxOS Puzzled Partitions

Weather Crossword

http://pclosmag.com/html/Issues/201704/files/2017-04-PuzzleSolutions.pdf
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More Screenshot Showcase

Posted by tbschommer, March 17, 2017, running KDE. Posted by YouCanToo, March 1, 2017, running KDE.

Posted by uncleV, March 14, 2017, running KDE. Posted by tuxlink, March 2, 2017, running KDE.




